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use hashtags for Instagram
effectively
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STEP 1

RECORD WHERE
YOU ARE NOW:

Before we dig in deep, let's start by recording the number

of followers and your account reach at the moment.

Get the information from Instagram app on your phone or

through the insights section on Meta business suite

Date
1446 MB O Al al 24%&
& Insights ®
Previous month v 1 Aug - 31 Aug
Followers
Overview
You reached +971% more accounts compared to
1 Jul - 31 Jul
Accounts reached 75
+971%
Accounts engaged 15
Account Reach wain >
Total followers 416 >
Content you've shared Seeall

Posts 4>

Reels 1>

11 8| £
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STEP 2

BE NOSY - LOOK AT
COMPETITORS:

Lesson 2.1

Think about your competitors, small and large. List their
accounts here:

Competitors Account Names

Click on their posts.

Look at the hashtags they use.

Copy interesting and relevant hashtags into the Full List tab
on your spreadsheet

A B c

1 Instagram Mon - Tue
Hashtag = |Posts = Theme 1 = The
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STEP 3

BE NOSY - LOOK AT

FOLLOWERS:

Lesson 2.1

Look at the accounts of
your followers or followers
of your competitors.

On their profile page, click
on their Following, look at
the Hashtag tab to see
which hashtags they may
be following

Following

Hashtags

#canvades |g nchalienge

3
©> 185267 posts

Following

#davinamenopause R
e . Raus Following

#selfiediscovery R
@ i, 4 Following
365 posts

":’“ fTU;D:dra\'fs:_:chse == Following

Copy interesting and relevant hashtags to the Full List tab

on the spreadsheet

Ideally choose hashtags with over 999 posts. If you are a

small account, choose hashtags with

less than 1 million

posts. If you are a larger account, you can use hashtags

with over 1 million posts
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STEP 4

BRAINDUMP

Lesson 2.1
Think about hashtags your ideal client would follow. Start typing in
the Instagram search bar, with # at the front

Relevant Subjects

Copy interesting and relevant @ Search
hashtags to the Full List tab on the
spreadsheet. If you can see the
number of posts, add that to the
spreadsheet too as you go along

#instagramtips

Ideally choose hashtags with over 999
posts. If you are a small account,

#instagramtipsforbusiness
283410 posts

choose hashtags with less than 1 o * ) Dreons
million posts. If you are a larger 4 Firsssrmipscay
account, you can use hashtags with I
over 1 million posts a ¥/ oo
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STEP 5

THINK LOCAL

Lesson 2.1
List your town, county, region and any other geographical

names here. E.g. Marlow, Buckinghamshire, Thames Valley,
Chilterns

Geographical Names

Put these into the search bar - with the hashtag symbol in
front.

A B (o]

Instagram Mon - Tue

Copy interesting and 1 Hashtag =Posts = Theme1 = The
relevant hashtags to the Full
List tab on the spreadsheet.

If you can see the number of
posts, add that to the ’
spreadsheet too as you go -
along. o
Ideally choose hashtags with '
over 999 posts. If you are a 5
small account, choose
hashtags with less than 1
million posts. If you are a

larger account, you can use
hashtags with over 1 million
posts
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STEP 6

USING Al

Lesson 2.4

Create an account on !:
chatgpt and/ or Google
pard

Create a new chat and
ask it to give you hashtags

on various topics. m

Copy interesting and
relevant hashtags to the
Full List tab on the
spreadsheet.

STEP 7

REVIEW HASHTAGS
YOU'VE COLLECTED

Lesson 3.1
Review the hashtags collected on the spreadsheet.

Check the content of each hashtag is relevant to your business and

your audience.

Add the number of posts for the hashtag to the Instagram Posts

column, if you haven’t done so already.
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STEP 8

FILTER OUT
HASHTAGS

{ashtag

Lesson 3.2 and 3.3

The next step is to filter
out the hashtags with too
few and to many posts.
For example we filter on
hashtags between 1000
and say 1,000,000 posts.

Click on the little down
arrow by Instagram Posts
(column B)

See separate videos for
excel and googlesheets

Excel

B C D

~ Instagram Post ~ Mon - Theme 1 ~ Tue - Theme 2 ~ Wed - Ther

x

Show rows where:
Instagram Posts

is greater than or equal... v [1000

® and O Or

is less than or equal to  ~| | 1000000

Use 7 to represent any single character
Use * to represent any series of characters

oK Cancel

Googlesheet

B

Hashtag

SortAto Z
SortZto A

Sort by colour

Filter by colour

» Filter by condition
Is not between

1000

and

1000000

~ Filter by values

Select all - Clear

+ (Blanks)

Copy h
click to

Cancel

Instagram
Posts

Ak
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STEP 9

CHOOSE YOUR HASHTAGS

If you post more than twice a week, | recommend using the
advanced social media strategy - so skip to step 13

Lesson 3.2 & 3.3

. Instagram Basic
Review the hashtags and  Hashtag = Posts = Hashtags
decide on 20 you want to use. #example1 2440

#example2 5500 Yes

. . Hexample3 6,640
If it helps to organise and Hexampled 300,000 Yes
count these, put Yes in the  #eamples 200,000 Yes
Basic Hashtag column. exampiet 300000

Copy hashtags above here - right The count will show

click to add mare lines if need be

at the bottom

leave this line empty
Total Hashtags 3

Then filter on Yes in the Basic Hashtags column

Googlesheets Excel
- e rzm FE < i ~ Instagram Post ~ Basic Hashtags ~ | Mon - Them
= Posts ?lHasMngs ?l_ﬂ 2] SotAtez
1 SortAtoz Z| sotZtoa
s SortZto A Sort by Color > C||Ck on the dOWn
4 Sort by colour » eet View > H
: e e arrow to the right of
»::::z:zz:]n(l\::\on ] BOSiC HOShtOgS'
~ Filter by values Text Filters »
— o EEtSelmAm Untick Blanks
W Yes i
ke Oty Click on OK
e (R =5
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STEP 10

COPY TO THE SHORTLIST

Copy the hashtags to the

the Basic Hashtags
column in the Shortlist
tab

STEP 11

HOW TO USE YOUR

HASHTAGS

For a better experience for
your followers, copy the
hashtags from the
Consolidated Lists Cell into

the bottom of your Instagram
posts.

This will create a block of
hashtags in your post, rather
than a long list.

Day >

Basic Hashtags

1 #example2
2 #example?
3 #exampled
4 #examplel0
5 #examplel2
6 #examplels
7 #examplel?
B #examplels
9 #example20
10 #example22
11 #example23
12 #example24
13 #example2s
14 #example27
15 #example29
16 #example30
17 #example33
18 #example34
19 #example3s
20 #example3d?
21
22
23

Day -»

Basic Hashtags

Mon -T

26
27
28
29
30

Consolidated

lists

#example2 #gexample7
#exampled #exampleld
#examplel #examplels
#examplel? #exampleld
#example20 #example22
#example23 #example24
#examplels #example27
#example29 #example30
#example33 #example3d
#example3s #example3?
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CONGRATULATIONS

You've now mastered how to:

Research hashtags

Check hashtags are aligned and relevant

Choose the best hashtags for your business and clients
Create a hashtag bank

Create a hashtag shortlist

Filter in spreadsheets (Bet you weren’t expecting that onel)
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ADVANC

STEP 13

If you post more than twice a week, | recommend using the

advanced social media strategy - so skip to step x

ALIGN SOCIAL MEDIA TO
HASHTAGS

Lesson 4.1
Decide how often you are going to post on social media.

Decide what the theme for the day of the week will be

In the full list tab, update the theme next to the day of
the week, so it's easier to manage going forward

A B c D E F G H 1

1 Instagram Mon - Tue - Wed - Thu - Fri - Theme Sat - Sun -
Hashtag = Posts = Theme1 = Theme2 = Theme3 = Themed4 = 5 = Theme6 = Theme7
7
8
9
10
L]

1
12

STEP 14

SELECT HASHAGS TO USE

Lesson 4.2 / 4.3

Decide which hashtags to use for each day / theme. Put
a Yes in the appropriate Day / Theme column. Ideally
you want to use 20 per day or theme. See Total
hashtags row for the count so far

A B c D E F G

1 Instagram Mon - Tue - Wed - Thu - Fri - Theme Sz
Hashtag = Posts = Theme1 = Theme2 = Theme3 = Themed = 5 = Th

T Hexamplel 2,440 yes

8 #Hexample2 5,500 yes

9 #Hexample3 6.640 yes

10 #example4 900.000 yes

1 #exampleS 200,000 yes

12 #exampleb 300,000 yes

13
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ADVANC

STEP 15

CREATE SHORTLISTS

Lesson 4.2./ 4.3
We now filter by each day in turn and copy the
hashtags for each day / theme to the short list tab:

For each day / them in turn
Click on the down arrow to the right of the Day.
Filter by "yes” (tick), untick blanks.

Click on OK
Googlesheet Excel
B c D gram Post - Basic Hashtags ~ Mon - Theme 1 +|Tue - Therr
Instagram Mon - Tue - A
= Posts = |Theme 1 ?.Theme 2 2 Zl SortAto Z
[ 3
SortAtoZ 5| Rl SortZtoa Yes
yes
SortZto A yes 5 Sort by Color > Yes
Sort by colour > 900, Sheet View >
Filter by colour - 2004
+ Filter by condition 300 Filter by Calor >
~ Filter by values Text Filters >
Select all - Clear search
-] (Select All)
a ~EN
(Blanks) Ves
i..[] (Blanks)
v yes
Cancel “ | Cancel |

Copy the hashtags to the
appropriate column in
the Shortlist tab
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STEP 16

COPY TO THE SHORTLIST

Copy the hashtags to the

appropriate
the Shortlist tab

column

in

Day =

ADVANCED

Mon - Theme 1

STEP 17

CLEAR FILTER AND REPEAT

Now clear the data in current column / day / theme

Googlesheets -
Select All - Click OK

Mon -
Theme 1 T

Tue
The
*

SortAtoZ |Yes

Instagram Basic
= Posts = Hashtags =

SortZto A

Sort by colour

Filter by colour
» Filter by condition
~ Filter by values

Select all - Clear

v Yes

(Blanks)

Cancel n

© Copyright 2023 Sarah Hobbs trading as Flow Grow Social. All rights reserved

1 #example2
2 #example?
3 #exampled
4 #examplelD
5 #examplel2
6 #examplels
7 #examplel?
8 #examplel8
9 #example20
10 #example22
11 #example23
12 #example24
13 #example2s
14 #example27
15 #example2s
16 #example30
17 #example33
18 #example3d
19 #example3s
20 #example37

A~

Excel - Clear filter

B

(@ D

am Post ~ Basic Hashtags ~ Mon - Theme 1 | Tue - Tt

5

2] SotAtez
Z] sotZtoa
Sort by Color

Sheet View

? Clear Filter From "Maon - Theme 1"

Filter by Colar

Text Filters

Yes

| Search

/] (Select All
M2

L Yes

.. (Blanks)

Now repeat steps x
toy for each Day /
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ADVANCED

STEP 18

HOW TO USE YOUR
HASHTAGS

Day - Mon - Theme 1 Tue -T
For a better experience for 16 #example30
17 #example33
your followers, copy the 18 #example3a
hashtags from the 19 #example3s
. . . |
Consolidated Lists Cell into el
the bottom of your Instagram 2
23
posts. ”
25
26
. . 27
This will create a block of 2
hashtags in your post, rather 29

than a long list. 2

#example2 #example?

#examples #examplel0

#examplel2 #examplels
Consolidated #examplel7 #examplel8
lists #example20 #example22

CONGRATULATIONS

You've now mastered how to:

Research hashtags

Check hashtags are aligned and relevant

Choose the best hashtags for your business and clients
Created a hashtag bank

Align hashtags to your social media strategy

Create hashtag shortlist

e Filter in spreadsheets (Bet you weren't expecting that one!)
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THANKS FOR FOLLOWING THE
COURSE

HERE'S A BIT ABOUT ME
SARAH HOBBS

Hi I'm Sarah. | love helping people get that lightbulb moment when |
explain the nitty-gritty bits of social media and websites and how it
can help their business.

| specialise in helping small businesses and sole traders understand
the connections between their social media and websites (and other
selling platforms), to build a sales and social media strategy, which
ultimately leads to feeling confident using social media and at the
same time growing sales.

I've a couple of decades of experience teaching non technical
people how to understand enough to use various tools in systems to
help their business. | take everything back to basics. Then take you
step by step through what you need to know to get results.

| know what it feels like to be thrown by hashtags. | felt the same
when | started using Instagram at few years ago. Not to be deterred,
| pulled by organising and problem solving skills together to get a
hashtag system in place. I've put this to use a number of times to
?elllp my social media management clients’ Instagram accounts grow
ollowers.

I've been told I'm extremely calm and patient so don’'t worry, we'll
get you there.

Find out more flowgrowsocial.com
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